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Delimitación automática de microcuencas utilizando datos 

SRTM de la NASA 

(Automatic delimitation of microwatershed using SRTM data of 

the NASA) 

Freddy Aníbal Jumbo Castillo1 

Resumen: 

La cuenca hidrográfica considerada como la unidad territorial básica de planificación y gestión 

de los recursos hídricos, requiere la adecuada delimitación del área de captación o drenaje, 

ante tal situación la carencia de información geográfica de microcuencas de la unidad 

hidrográfica del río Casacay debe solucionarse, para tal efecto la investigación tuvo como 

objetivo la delimitación automática de microcuencas utilizando técnicas de Sistemas de 

Información Geográfica (SIG) y datos del proyecto Shuttle Radar Topographic Mission (SRTM) 

de 30 metros de resolución espacial. La metodología seleccionada fue la de Pfafstetter, con la 

cual se obtuvieron nueve microcuencas con su respectiva codificación, permitiendo continuar 

con la estandarización de cuencas adoptada por la Secretaría del Agua de Ecuador. Con los 

resultados de la investigación se actualiza la información de cuencas con mayor detalle, 

favoreciendo la ejecución de las tareas o actividades relacionadas con la gestión integral de la 

unidad hidrográfica estudiada.   

 

Palabras clave: Cuenca hidrográfica; método Pfafstetter; delimitación automática; Modelo 

Digital de Elevación, Sistemas de Información Geográfica.  

 

Abstract: 

The watershed as the basic territorial unit of planning and management of water resources, 

requires its proper delimitation of the catchment or drainage area, faced with this situation, the 

lack of geographic information of Casacay river micro watersheds, hydrographic unit should be 

resolved, for this purpose the research was aimed at automatic delimitation of micro watersheds 

using of Geographic Information Systems (GIS) techniques and the project Shuttle Radar 

Topographic Mission (SRTM) 30 meters spatial resolution data. The selected methodology was 

the Pfafstetter one, with which nine micro watersheds were obtained with their respective 

codification allowing to continue with watersheds standardization adopted by Ecuador Water's 

Secretariat. With the investigation results watersheds will be updated with more detail 

information, promoting the execution of tasks or activities related to the integrated management 

of the hydrographic unit studied. 

 

Keywords: Watershed; Pfafstetter method; automatic delimitation; Digital Elevation Model; 

Geographic Information Systems. 
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1. Introducción 

El Ecuador a través de la Secretaría del Agua, se encarga de la gestión de los recursos hídricos, 

en cumplimiento a lo estipulado en la Ley Orgánica de Recursos Hídricos, Usos y 

Aprovechamiento del Agua publicado en el Registro Oficial Nº 305 del 6 de agosto de 2014, donde 

se considera a la cuenca hidrográfica como la unidad territorial básica de planificación y 

administración de los recursos existentes en su entorno. 

De acuerdo al CNRH (2002), la cuenca es aquella área de drenaje que está delimitada por una 

línea divisoria de las aguas, la cual corresponde a las máximas alturas o elevaciones. En 1989 

con Pfafstetter surge el concepto de unidad hidrográfica, definiéndola como áreas de drenaje 

cuyos límites se encuentran definidos por las líneas divisorias de aguas, relacionadas por su 

código espacialmente y cuya jerarquización se basa en el tamaño de las áreas de captación. La 

importancia de la cuenca como unidad de planificación, radica en que al funcionar sistémicamente 

no solo se analizan aspectos hidrológicos, sino también desde la perspectiva biológica o 

ambiental.    

Según Gomes & Lobão (2009), la delimitación de cuencas es fundamental y va más allá del 

establecimiento del límite natural del área de drenaje, hasta convertirse en la unidad principal de 

análisis ambiental, permitiendo identificar y evaluar procesos, así como las interacciones que en 

ella ocurran, aspectos esenciales para la planificación y toma de decisiones sobre los recursos 

naturales. Lo anteriormente mencionado aplica también para la definición de microcuenca y es 

corroborado por Casillas (2006), quien manifiesta que microcuencas son las unidades 

naturales que sirven como base territorial para articular procesos de gestión, que promueven el 

desarrollo integral y sustentable.  

La delimitación automática de áreas de drenajes, ha remplazado el método tradicional realizado 

manualmente sobre la carta topográfica, disminuyendo esfuerzos y optimizando recursos. El 

procedimiento para la obtención de cuencas, subcuencas y microcuencas hidrográficas, se ha 

fortalecido en función al crecimiento vertiginoso que han tenido en los últimos años los Sistemas 

de Información Geográficos (SIG), que han aportado con nuevas herramientas enfocadas a 

estudios hidrográficos. Para Guevara (1987), los SIG se han adaptado a los avances tecnológicos, 

proporcionando nuevos medios para la manipulación y análisis de información en función a la 

perspectiva del usuario y del problema a resolver. 

Varios estudios realizados para la obtención de unidades hidrográficas, han utilizado como insumo 

principal los datos liberados por la misión Shuttle Radar Topography Mission (SRTM), 

destacándose los aportes de Alves et al. (2010), Pontes et al. (2009) y Gomes et al. (2007). El 

SRTM obtuvo información altimétrica de la tierra utilizando la técnica radar interferometría, la cual 
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se encuentra disponible públicamente a nivel mundial, en las versiones de 3 y 1 segundo de arco; 

es decir de 90 y 30 metros de resolución espacial respectivamente. 

Una de las metodologías para la delimitación de unidades hidrográficas es la de Pfafstetter, en los 

últimos años utilizada en varios países de Sudamérica, como demostración de su aplicación 

sobresalen los trabajos de Pires & Faria (2013), Gomes & Barros (2011), Secretaría del Ambiente 

(2011), UICN Sur & SGCAN (2010) y UICN (2009b). El Ecuador a través de la Secretaría del Agua 

(2011), oficializó la información geográfica de cuencas hasta el nivel 5 generadas según el método 

Pfafstetter, las cuáles son análogas a la denominación de subcuencas y obtenidas utilizando el 

MDE de 90 metros de resolución espacial, que según la UICN (2009a), no era óptimo para 

incrementar los niveles de subdivisión de unidades hidrográficas. 

La unidad hidrográfica del río Casacay es una de las más representativas de la cuenca baja del río 

Jubones dadas las actividades que en ella se ejecutan, por lo cual la falta de información espacial 

de unidades de drenaje a mayor detalle, equivalentes al nivel de microcuencas afectan los 

procesos de gestión relacionados con los recursos hídricos, así como las tareas enfocadas a la 

conservación del paisaje natural. De este modo el objetivo de este trabajo es delimitar 

automáticamente las microcuencas correspondientes a la unidad hidrográfica del río Casacay, 

utilizando técnicas de SIG y datos SRTM de 30 metros de resolución espacial, que permita la 

actualización de información geográfica, para el soporte a la correcta toma de decisiones en la 

gestión y conservación de los recursos hídricos. 

Como hipótesis se planteó lo siguiente: La resolución espacial del MDE influye significativamente 

en la delimitación de las microcuencas de la unidad hidrográfica del río Casacay.  

2. Metodología 

La unidad hidrográfica del río Casacay, geográficamente está localizada en la parte baja de la 

cuenca del río Jubones, correspondiente a la Demarcación Hidrográfica de Jubones (DHJ), como 

se puede apreciar en la Figura 1. Su extensión territorial es de 12,178 ha y cubre parte de los 

cantones de Chilla y Pasaje, pertenecientes a la provincia de El Oro. 
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Figura 1. Ubicación geográfica de la subcuenca del río Casacay. 

Las coordenadas métricas de localización de la unidad hidrográfica en datum WGS84 UTM Zona 

17 Sur, se especifican en la Tabla 1. 

 Tabla 1. Coordenadas de localización. 

Orientación X Y 

NORTE 641,017 9,633,388 

SUR 655,268 9,614,627 

ESTE 655,913 9,620,502 

OESTE 643,178 9,623,799 

 

La cartografía base existente para la ejecución de este proyecto, es la unidad hidrográfica en nivel 

5 del río Casacay, así como la cartografía oficial liberada por el Instituto Geográfico Militar (IGM) a 

escala 1:50,000 y 1:250,000, correspondiente a la hidrografía del área de estudio. Los archivos se 

encuentran disponibles en formato shapefile. 

El proceso de delimitación se regirá bajo las normativas establecidas por el método Pfafstetter, 

que según la UICN (2009b), identifica 3 tipos de unidades hidrográficas descritas a continuación: 

 Cuenca: Es el área de captación que no recibe drenaje de ninguna otra área, pero que sí 

aporta con flujo a otra unidad hidrográfica. 

 Intercuenca: Es considerada como una unidad de drenaje de transito del río principal, a la 

cual también aporta su propio recurso hídrico. Se puede mencionar también, que es 

aquella unidad que capta el flujo de una unidad hidrográfica que se ubica aguas arriba, y 

que drena por el río principal conjuntamente con el caudal que genera.    

 Cuenca interna: Es el área de drenaje aislada que no recibe flujo ni aporta caudal a otra 

área de captación. 

La metodología Pfafstetter seleccionada para el proceso de delimitación de las microcuencas se 

representa gráficamente a través de la Figura 2. 
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Figura 2. Diagrama de la metodología. 

Cada una de las etapas de la metodología se llevará a cabo utilizando la herramienta de SIG 

ArcGIS 10, las cuales son descritas a continuación: 

Obtención de datos SRTM y pre-procesamiento: Los datos altimétricos de 30 metros de 

resolución espacial correspondiente al MDE del área de estudio, están disponibles para la 

descarga desde la página http://earthexplorer.usgs.gov/. En el visor se especifican las 

coordenadas de localización de la unidad hidrográfica del río Casacay. 

El pre-procesamiento consiste en la eliminación de imperfecciones de fuente de origen presentes 

en el MDE, dentro de los cuales se encuentran las zonas sin datos o vacías “NoData”, que según 

Olaya (2011) deben corregirse aplicando métodos de interpolación. Otro factor que afecta la 

calidad de los datos SRTM, es la presencia de picos y sumideros, que de acuerdo a Medeiros et 

al. (2009), las imperfecciones presentes en el modelo de datos ocasionan errores en el mapa de la 

dirección de flujo. 

Una de las formas de eliminar la presencia de valores NoData en el modelo es mediante 

estadisticas focales, procedimiento que se efectúa a través del la herramienta ArcToolbox>Spatial 

Analyst Tools>Map Algebra>Raster Calculator. Posteriormente se corrijen los picos y sumideros a 

través del recurso Spatial Analyst>Hidrology>Fill. 

Dirección de flujo: En esta etapa se obtiene un raster con las orientaciones de flujo de cada 

celda vecina, calculadas en función a las pendientes. Walchholz et al. (2013), menciona que las 

direcciones de flujo expresan las relaciones hidrológicas entre diferentes puntos de una cuenca 

hidrográfica. 

Para ESRI(2013a), el cálculo de dirección de flujo es un proceso sigue la secuencia mostrada en 

la Figura 3.  

Obtención de datos 
SRTM y pre-

procesamiento 

Dirección 
de flujo 

Acumulación de 
flujo y cálculo 

del umbral 

Red de 
drenajes 

Generación 
de cuencas 

Vectorización 
y codificación 

http://earthexplorer.usgs.gov/
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Figura 3. Procedimiento de cálculo de dirección de flujo. 

La dirección de flujo se obtiene a través del recurso ArcToolbox>Spatial Analyst>Hidrology>Flow  

Direction. 

Acumulación de flujo y cálculo del umbral: La acumulación de flujo determina todas las celdas 

que drenan a una en particular, la cual se obtiene a partir de la dirección de flujo. Según 

Venkatachalam et al. (2001), la acumulación de flujo en una celda se establece en función a la 

suma de los valores de acumulación de flujo de las celdas vecinas que desembocan en ella. 

De acuerdo a ESRI (2013b), la acumulación de flujo es un proceso que sigue la secuencia 

especificada en la Figura 4.    

 
Figura 4. Procedimiento de cálculo de acumulación de flujo. 

La acumulación de flujo se obtiene a través del recurso ArcToolbox>Spatial 

Analyst>Hidrology>Flow  Acumulation. 

La siguiente tarea se denomina cálculo del umbral, que para ESRI (2012), el proceso requiere del 

raster de acumulación de flujo y la cantidad mínima de celdas que forman el curso de agua, las 

cuales corresponden al valor del umbral. De acuerdo a la UICN (2009a), se obtiene mediante un 

procedimiento repetitivo de ensayo y error, con el cual se determina el umbral de acumulación que 

permite identificar el afluente principal y cuatro aportantes. Con los resultados se determinan las 4 
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unidades de drenaje tipo cuenca y 5 de tipo intercuenca, correspondiéndoles a las primeras las 

mayores áreas de drenaje y acumulación de flujo según el método Pfafstetter. 

En ArcGIS el proceso se realiza desde ventana Layer>Properties>Symbology>Classified>Classify, 

donde se especifica la clasificación en dos rangos o clases aplicando el método Natural Breaks ‐ 

Jenks; el primero va de 1 a N valor calculado por la herramienta, mientras que el segundo del N 

valor al número máximo que alcanza la acumulación de flujo. El valor N es con el cual se realizan 

los ensayos a través de la opción Classify>Break Value. 

El cálculo del umbral finaliza con la reclasificación de los resultados obtenidos, y se realiza por 

medio de la herramienta ArcToolbox>Spatial Analyst Tools>Reclass>Reclassify, asignándole el 

valor de 0 al primer rango y 1 al segundo rango, siendo el segundo rango el requerido para la 

siguiente etapa del proceso, ya que almacena los afluentes principales. (UICN Sur & SGCAN, 

2010)   

Red de drenajes: La generación de la red de drenajes es fundamental para la determinación de 

las cuencas hidrográficas, el insumo principal en esta etapa es la reclasificación de la acumulación 

del rango cuyo valor asignado fue 1 en la anterior fase.  

El procedimiento se realiza desde la caja de herramientas ArcToolbox>Spatial Analyst 

Tools>Hydrology>Stream Link. Según criterio de Johnson (2008), Stream Link asigna valores 

únicos a las secciones de una red de drenajes entre las intersecciones, que para la UICN (2009b), 

los enlaces o links son los segmentos de una red de drenajes que conectan a dos aportantes de 

forma sucesiva.     

Generación de cuencas: Según Alves et al. (2010), el proceso para la generación de las áreas 

de drenaje requiere del mapa de dirección y acumulación de flujo y se lo realiza mediante la 

herramienta ArcToolbox>Spatial Analyst Tools>Hydrology>Wathershed. 

Para UICN (2009b), Wathershed establece el área aportante de la cuenca que drena dentro de 

ella y fluye a una determinada salida. 

Vectorización y codificación: La vectorización consiste en convertir las cuencas de formato 

raster a vector. Es la etapa final de la metodología y arroja como resultado el archivo shapefile con 

los polígonos de las unidades hidrográficas delimitadas. De acuerdo a lo establecido por la 

UICN(2009b) en el manual de procedimientos de delimitación y codificación de unidades 

hidrográficas para el Ecuador, la vectorización de las cuencas se logra a través de la siguiente 

herramienta ArcToolbox>Conversion Tools>From Raster>Raster To Polygon. 

Las codificación de cuencas hidrográficas basadas en el método Pfafstetter (1989), es jerárquica y 

utiliza 10 digitos relacionados directamente con el área de drenaje y cursos de agua. Según 

Galvão & Meneses (2005), los códigos pares 2, 4, 6 y 8 se asignan a las cuatro cuencas 
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principales a las cuales corresponden las mayores áreas de drenaje, mientras que las 

intercuencas identifican a las cinco unidades de drenaje de menor tamaño y reciben los digitos 1, 

3, 5, 7 y 9. La Secretaría del Ambiente (2011), corrobora lo manifestado por los autores 

anteriormente, pero además manifiesta que en caso de existir intercuencas, éstas se codifican con 

el digito 0, como se puede observar en la Figura 5. 

 
Figura 5. Codificación del método Pfasfstetter. 

El proceso de codificación se realiza desde aguas abajo(desembocadura), hacia aguas arriba 

(naciente de la cuenca). En ArcGIS el digito correspondiente a cada unidad hidrográfica se asigna 

en la tabla de atributos del archivo vectorial shapefile de las unidades delimitadas. 

 

3. Resultados y Discusión 

Los resultados son presentados en función a los productos obtenidos en cada etapa de la 

metodología: 

Obtención de datos SRTM y pre-procesamiento: Se descargó el MDE en formato GeoTIFF, de 

acuerdo a las coordenadas de localización de la unidad hidrográfica del río Casacay. Como 

resultado del pre-procesamiento se corrigieron las celdas que contenían valores NoData y se 

eliminaron los picos y sumideros presentes en el modelo, lo cual se puede observar en la Figura 6. 
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Figura 6. Resultados obtención de datos y pre-procesamiento. 

Es fundamental para el desempeño eficaz de las siguientes etapas de la delimitación, las 

correcciones realizadas al MDE, dentro de las cuales se encuentra el llenado de celdas de valores 

NoData y la depuración de picos y sumideros. El orden de ejecución de las correcciones garantizó 

el resultado del procesamiento.   

Se destaca en la optimización del modelo la aplicación de estadísticas focales, el uso del algebra 

de mapas, los algoritmos de interpolación del vecino próximo y la definición de un radio de acción 

de 10 celdas. 

Dirección de flujo: Se obtuvo el raster de la dirección de flujo, en donde cada celda almacena el 

valor de dirección con pendiente máxima.   

 
Figura 7. Dirección de flujo. 

La dirección de flujo se generó a partir del MDE depurado, los valores de dirección varían de 1 a 

128, y se asignan en función a la pendiente con respecto a las celdas vecinas. 

Acumulación de flujo y cálculo del umbral: Esta fase arrojó como resultado el raster de 

acumulación de flujo, sobre el cual se realizó el procedimiento del cálculo del umbral, lo cual se 

muestra en la Figura 8.  
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Figura 8. Acumulación de flujo y cálculo del umbral. 

El raster de acumulación de flujo se clasificó en dos clases. En la segunda clase se especificó el 

valor de 8,700, el cual se estableció como el umbral de acumulación permitiendo identificar el flujo 

del río principal y de sus cuatro aportantes. 

Red de drenajes: Se obtuvo el raster de red de drenajes que identifica el curso principal del río, y 

los cuatro aportantes principales que definen a las unidades hidrográficas tipo cuenca, los cuales 

se enumeran con digitos pares en la Figura 9.   

 
Figura 9. Mapa red de drenajes. 

Además, la red de drenajes determina las 5 unidades hidrográficas tipo intercuenca. A los 

segmentos correspondientes a las nueve unidades hidrográficas, el proceso automático les asigna 

un único código.    
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Generación de cuencas: El resultado de esta etapa es la delimitación o generación automática 

del archivo ráster de las 9 unidades hidrográficas, las cuales se muestran en la Figura 10.  

 
Figura 10. Mapa de generación de cuencas. 

Para la generación de las cuencas, se necesitó de la dirección de flujo y la red de drenajes 

anteriormente obtenidos. 

Vectorización y codificación: Con la vectorización de las cuencas se obtuvo el archivo digital en 

formato ESRI shapefile datum WGS84 UTM zona 17 Sur, el cual contiene las 9 microcuencas 

delimitadas, correspondientes a la unidad hidrográfica del río Casacay. Se estableció además la 

codificación para cada una de las microcuencas. 

Para la presentación de los resultados, las microcuencas pasan a denominarse unidades 

hidrográficas en nivel 6 conforme los lineamientos del método Pfafstetter, lo cual se puede 

apreciar en la Figura 11.     
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Figura 11. Mapa de unidades hidrográficas delimitadas nivel 6. 

Los atributos establecidos en el archivo shapefile, para los 9 polígonos de las unidades de drenaje 

delimitadas, se pueden observar en la Tabla 2.  

Tabla 2. Atributos de las unidades hidrográficas delimitadas. 

Cuenca Nivel 6 Nombre 6 Tipo Área km
2
 Área Ha. 

Unidad 
hidrográfica 
río Casacay 

(Código nivel 5: 
13942) 

139421 Unidad hidrográfica 139421 Intercuenca 16.54 1,654.24 

139422 Unidad hidrográfica 139422 Cuenca 22.90 2,290.32 

139423 Unidad hidrográfica 139423 Intercuenca 18.29 1,829.69 

139424 Unidad hidrográfica 139424 Cuenca 8.65 865.99 

139425 Unidad hidrográfica 139425 Intercuenca 6.83 683.65 

139426 Unidad hidrográfica 139426 Cuenca 15.02 1,502.21 

139427 Unidad hidrográfica 139427 Intercuenca 1.36 136.10 
139428 Unidad hidrográfica 139428 Cuenca 8.26 826.54 

139429 Unidad hidrográfica 139429 Intercuenca 23.73 2,373.45 

 

Como se puede apreciar en la Tabla 2, la codificación del nivel 6 se obtuvo a partir del código nivel 

5, establecido para la unidad hidrográfica del río Casacay. El número de dígitos del código permite 

identificar el nivel de delimitación actual y conforme las directrices de la metodología se definieron 

las 4 unidades tipo cuenca y las 5 intercuencas. 

Los resultados de esta investigación, se integran adecuadamente a la información de cuencas 

hidrográficas oficializada por la Secretaría del Agua aplicando el método Pfafstetter. La topografía 

del terreno favoreció la delimitación de las unidades hidrográficas en nivel 6, permitiéndo obtener 

las áreas de captación, que por su tamaño y detalle favorecen el análisis de la distribución 

espacial de las comunidades, usuarios del agua y fuentes hídricas. 
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La subdivisión de la unidad hidrográfica del río Casacay, favorece la planificación y el trabajo de 

campo, de forma concreta se puede analizar la oferta hídrica estableciendo como punto de 

descarga la desembocadura de cada unidad hidrográfica en nivel 6.  

En los trabajos desarrollados por la UICN (2009a) no se incrementaron los niveles de delimitación, 

debido a que la resolución del MDE no era favorable para continuar subdividiendo el nivel 5, sin 

embargo las bases definidas en ese estudio, así como las del manual elaborado por la UICN 

(2009b), aportaron significativamente a la consecución del nivel 6 de unidades hidrográficas. En el 

estudio realizado por Ramírez et al. (2011), la base del proceso fue el SRTM de 90 metros, siendo 

necesario reproyectarlo a un MDE de 30 metros de resolución para cumplir con el propósito de la 

investigación.  

Con los datos SRTM de 30 metros de resolución espacial liberados por la NASA en el año 2014, 

la delimitación de cuencas, subcuencas y microcuencas; es factible, necesitándose corregir 

únicamente la presencia de errores de fuente.  

La propuesta desarrollada por el CNRH (2002), arrojó como resultado las cuencas y subcuencas 

del Ecuador, sin embargo el método con el cual se realizó el proceso de delimitación, obedecía a 

los requerimientos planteados a nivel de país y a la cartografía base disponible localmente.   

   4. Conclusiones y Recomendaciones 

A nivel de país se carece de información geográfica de unidades hidrográficas en nivel 6, con los 

resultados del presente trabajo se solucionó ese requerimiento para subcuenca del río Casacay. 

Los factores por los cuales se eligió la metodología Pfafstetter, fueron los diversos estudios 

desarrollados en diferentes países de Sudamérica, sustentándose también en la oficialización del 

uso del método para el Ecuador por parte de la Secretaría del Agua. Con la metodología se 

utilizaron los datos altimétricos del MDE de 30 metros de resolución espacial y la cartografía 

validada de cuencas hidrográficas disponible de forma oficial hasta el nivel 5; la cual fue 

delimitada en base al MDE de 90 metros de resolución.  

Los datos del MDE de 30 metros de resolución espacial liberados en el año 2014, presentan 

errores o celdas vacías en la parte alta de la cuenca del río Casacay, siendo necesario la 

utilización del algebra de mapas y estadísticas focales para el proceso de optimización, el cual 

consistió en llenar los vacíos con valores interpolados considerando un radio de acción de 10 

celdas, este último valor puede variar dependiendo del tamaño de la zona a corregir. Fue 

importante la optimización del MDE, puesto que se utilizó en cada una de las etapas de la 

metodología. 
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Con la utilización del MDE de la NASA, se omite en la delimitación de microcuencas el proceso 

para la generación de un MDE, a partir de la cartografía de curvas de nivel, la cual necesita de 

una revisión minuciosa para corregir los errores topológicos.   

El procedimiento automático para la generación de unidades hidrográficas en nivel 6, fue asistido 

por la herramienta Hydrology, arrojando resultados satisfactorios en cada fase. Para el 

establecimiento de las áreas de drenaje o captación, fue fundamental el cálculo del umbral de 

acumulación de la cuenca, ya que permitió identificar el curso del río principal y sus aportantes, 

contribuyendo a la identificación y obtención de las 9 unidades hidrográficas, equivalentes a la 

denominación de microcuencas.  

La codificación de las unidades de drenaje delimitadas se basó en el código 13942, establecido 

para la unidad hidrográfica nivel 5 del río Casacay. Las unidades hidrográficas codificadas fueron: 

139421, 139422, 139423, 139424, 139425, 139426, 139427, 139428 y 139429, las cuales 

corresponden al nivel 6 de acuerdo a los lineamientos definidos por el método aplicado. 

Los resultados obtenidos fueron almacenados en un archivo shapefile datum WGS84 UTM zona 

17 Sur, con el cual se actualiza la información geográfica de cuencas a mayor detalle y se 

beneficia a la gestión integral de los recursos hídricos, por lo tanto se cumple el objetivo planteado 

en esta investigación y se acepta la hipótesis formulada. Las microcuencas permiten continuar con 

la estandarización de unidades hidrográficas definida hasta el nivel 5 por la Secretaría del Agua. 

Es factible desarrollar el proceso de delimitación en nivel 6, para el resto de unidades 

hidrográficas oficializadas hasta el nivel 5 según el método Pfafstetter, sin embargo es importante 

que el organismo rector del agua conozca los resultados del estudio realizado, y los que puedan 

emprenderse para otras cuencas hidrográficas.  

La cartografía actualizada debe utilizarse para resolver otros requerimientos en la unidad 

hidrográfica del río Casacay, pero esencialmente valorar mediante un estudio la ocupación 

humana del territorio, el uso de la tierra actual y la tendencia de cambio. Las microcuencas 

obtenidas permiten la formulación de nuevos proyectos, orientados a la conservación de las 

fuentes hídricas que abastecen de agua a los cantones de El Guabo, Machala y Pasaje. 

Los resultados son valiosos para la gestión operativa y de alto nivel de la Secretaría del Agua - 

DHJ, esencialmente fortalecen el Plan Nacional de Recursos Hídricos y al proyecto emblemático 

de la institución denominado Inventario Participativo de Recursos Hídricos de la unidad 

hidrográfica del río Casacay, los cuales enfocan sus investigaciones a nivel de microcuencas. Con 

los datos de las unidades hidrográficas en nivel 6, se actualiza el banco de datos del sistema de 

autorizaciones de usos de agua y del inventario participativo.  
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